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 3 

 

Starting a new Quick Books company 
 

 A QuickBooks company contains all the financial records for a single business. If you are just 

starting out with QuickBooks, and if you are not a Quicken or QuickBooks for DOS user, the first thing 

you must do is create a QuickBooks company for your financial records. 

 

If you've already been using Quicken or QuickBooks We recommend that you use the EasyStep interview 

to create your QuickBooks company. The interview walks you through the setup procedure and helps you 

tailor QuickBooks to suit your business. The interview also creates, automatically, some of the QuickBooks 

accounts and items you'll need. 

 

Instructions 

 

1 From the File menu, choose New Company. 

2 (Mandatory) Fill in the information for all the tabs (Welcome, Company Info, Preferences, and 

Start Date) in the General section. 

3 When you have finished the General section, do one of the following: 

 

Changing to a different company file 

 

If you work with several companies, you'll be keeping their financial records in separate company files. 

You can change to another company file at any time. 

 

Instructions 

 

1 From the File menu, choose Open company. 

2 Click OK to confirm that you want to close the current company. 

 

QuickBooks asks you this question because you cannot have two company files open at the same time. 

 

3 In the window that appears, select the filename of the company you want to use and click Open. 

 

Can't find your company? 

 

Types of QuickBooks accounts 
 

There are two main types of accounts in QuickBooks' chart of accounts:  

 

 Balance sheet accounts 

 Income and expense accounts 
 

Balance sheet accounts 
 

QuickBooks provides nine types of balance sheet accounts to choose from as you create and add to your 

chart of accounts. The following table describes each type of balance sheet account and the transactions 

you can use it for. 

 

This account type . . Tracks the following 

Bank account Checking, savings, and money market accounts. Add one bank 

account for every account your company has at a bank or other 

financial institution. (You can also use this type for petty cash.) 
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 4 

Accounts receivable 

(A/R) Transactions related to the customers that owe you money, including 

invoices, payments, deposits of payments, refunds, credit memos, 

and statements. Most companies have only one A/R account. 

Other current asset Assets that are likely to be converted to cash or used up within one 

year, such as petty cash, notes receivable due within a year, prepaid 

expenses, and security deposits. 

Fixed asset Long-term notes receivable and depreciable assets your company 

owns that aren't likely to be converted into cash within a year, such 

as equipment or furniture. 

Accounts payable 

(A/P) Your company's outstanding bills, bill payments, and any credit you 

have with vendors. 

Credit card Credit card purchases, bills, and payments. 

Current liability Liabilities that are scheduled to be paid within one year, such as sales 

tax, payroll taxes, accrued or deferred salaries, and short-term loans. 

Long-term liability Liabilities such as loans or mortgages scheduled to be paid over 

periods longer than one year. 

Equity Owner's equity, including capital investment, drawings, and retained 

earnings.  

 

 bank 

 accounts receivable 

 accounts payable 

 fixed asset, other asset, other current asset 

 other current liability, long term liability 

 credit card 

 equity 

 

 

Income and expense accounts 
 

Income and expense accounts track the sources of your income and the purpose of each expense. When you 

record transactions in one of your balance sheet accounts, you usually assign the amount of the transaction 

to one or more income or expense accounts. For example, not only do you record that you took money out 

of your checking account, but you keep track of what you spent the money on: utilities, perhaps, or office 

supplies. 

QuickBooks does not display a balance for income and expense accounts in the chart of accounts. To see 

income and expense account balances, choose Profit and Loss from the Reports menu, or select the income 

or expense account in the chart of accounts and click QuickReport. 

 

Balance sheet accounts 

 

Accounts that appear on a balance sheet report. In QuickBooks, these include the following types of 

accounts: 

 

Each balance sheet account in QuickBooks has its own register that tracks the balance of the account. You 

can also see the account balances by looking at your chart of accounts. 

 

Income account 

 

An account that tracks the source of your company's income. (You can think of income as money that 

comes into the company.) Unlike balance sheet accounts, income accounts do not have a register of their 

own. You can get a list of the transactions posted to an income account by selecting the account in the chart 

of accounts and clicking QuickReport. 
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 5 

 

Expense account 

 

An account that tracks what your company is spending. (You can think of expenses as money that leaves 

the company.) Unlike balance sheet accounts, expense accounts do not have a register of their own. You 

can get a list of the transactions posted to an expense account by selecting the account in the chart of 

accounts and clicking QuickReport. 

 

Customers 
 

Adding a customer 

 

QuickBooks keeps information about customers on the Customer:Job list. You can add new customers to 

the list at any time. 

 

Instructions 

 

1 From the Lists menu, choose Customer:Job. 

2 Click New. 

3 In the Customer field, enter the name of the customer as you'd like it to appear on your 

Customer:Job list. 

 

For example, if the customer is Hayley Green and you want the list to show last names first, you would 

enter Green, Hayley. 

 

4 On the Address Info tab, enter the following information about the customer: 

 

Company name If applicable, fill in the customer's company name. 

Mr./Ms./ Enter the customer's salutation or title (Mr., Ms., Dr., etc.) here. For a 

married couple, you can enter "Mr. and Mrs." 

First name  

Last name Enter the first name, middle initial, and last name of the person who is 

your main contact when you do business with this customer. 

Bill to Complete the customer's billing address (QuickBooks has partially 

filled in the address on the basis of what you've entered so far). Enter 

the address as you want it to appear on printed invoices, checks, and 

other forms.The address information you enter can be exported for mail 

merge. If you use mail merge, be sure to include in the last line of the 

address the two letter state abbreviation and the zip code. This ensures 

that the address will print correctly in mail merge documents. 

Ship to If the customer has a separate shipping address, enter the address as 

you'd like it to appear on printed invoices and other forms. If the 

shipping address is the same as the billing address, click Copy to copy 

the billing address to the Ship To field. 

Phone 

FAX 

Alt. Ph. 

Alt. contact Enter, as needed, the customer's phone number, FAX number, alternate 

phone number, and the name of an alternate contact person. 

 

5 Click the Additional Info tab. Enter the following information about the Customer: 

 

Type This is a word or phase that categorizes this customer for your reports. 

You can choose a customer type you have already set up from the drop-
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 6 

down list, or you can enter a new customer type and have QuickBooks 

add it to the list.Examples 

Terms This field lets you associate a specific set of payment terms with the 

customer. You can choose an existing set of terms from the drop-down 

list, or you can enter a new set of terms and have QuickBooks add it to 

the list.ExampleHow the terms are used 

Rep Enter the initials of the sales representative who deals with this customer 

on a regular basis. When you write an invoice to this customer, 

QuickBooks automatically enters the initials into the Rep field of the 

invoice if you are using the product invoice  format or if you have added 

the Rep field to a custom invoice format.If your invoices don't have a 

Rep field 

Credit limit (Optional) Enter the credit limit that the customer has with your 

company. QuickBooks remembers the limit and warns you when the 

customer is about to exceed the limit. 

Opening balances 
 

As of These two fields apply only if you are setting up records for a new 

QuickBooks company. They help you establish a correct accounts 

receivable balance as of the  start date you chose for your QuickBooks 

records.How to enter the opening balance 

Customer is taxable When this checkbox is selected, QuickBooks automatically calculates 

sales tax for each taxable item you sell to this customer. QuickBooks 

uses the sales tax rate specified in the Tax Item field.If you do not 

charge sales tax to this customer, clear the checkbox.If there is no 

checkbox 

Tax Item Specifies the sales tax rate QuickBooks uses to calculate sales tax when 

you sell taxable items to this customer. If the rate shown is incorrect for 

this customer, choose the correct rate from the drop-down list.If there is 

no Tax Item field 

Resale number If the customer has a resale number, enter the resale number. This field 

is for your information -- what you enter will not affect your reports, or 

how sales tax works in QuickBooks.Tip. Ordinarily you don't charge 

sales tax on items that a customer buys for resale. If this customer is 

strictly a resale customer, be sure to clear the "Customer is taxable" 

checkbox. 

 

6 (Optional) On the Additional Info tab, fill in any customized fields that apply to this customer. 

 

How to create custom fields 

 

7 Record the information you entered by doing one of the following: 

 

 Click Next to add another customer to the list. 

 Click OK to close the window. 

 

Suppliers 
 

Adding a vendor 

 

QuickBooks uses the Vendor list to hold information about the people and companies you do business with. 

You can select a vendor from the list when writing purchase orders, entering bills you've received, writing 

checks, or recording credit card purchases. You can add new vendors to the list at any time. 
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 7 

 

Instructions 

 

1 From the Lists menu, choose Vendor. 

2 Click New. 

3 In the Vendor field, enter the name of the vendor as you'd like it to appear on your Vendor list. 

 

For example, if the vendor is an individual and you list individuals last name first, that's how you should 

enter the name. 

 

4 On the Address Info tab, enter the following address and contact information about the vendor: 

 

Company name Fill in the vendor's company name.1099s. If you send a 1099-MISC 

form to this vendor, enter the company's legal name. 

Mr./Ms./ Enter the vendor's salutation or title (Mr., Ms., Dr., etc.) here. For a 

married couple, you can enter "Mr. and Mrs." 

First name 

M.I. 

Last name Enter the first name, middle initial (M.I.), and last name of the person 

who is your main contact when you do business with this vendor. If the 

vendor is a large corporation (for example, your utility company), you 

can leave these fields blank.1099s. If you send a 1099-MISC form to 

this vendor, enter the vendor's legal name in these fields. 

Address Complete the vendor's address (QuickBooks has partially filled in the 

Address field on the basis of what you've entered so far). Enter the 

address as you want it to appear on printed checks to the vendor.Mail 

merge. If you use mail merge, be sure to include in the last line of the 

address the two letter state abbreviation and the zip code. This ensures 

that the address will print correctly in mail merge documents.1099s. If 

you send a 1099-MISC form to this vendor, you must include the city, 

the two-letter state abbreviation, and the zip code. Do not change the 

part of the address that QuickBooks filled in. 

Phone 

FAX 

Alt. Ph. 

Alt. contact Enter, as needed, the vendor's phone number, fax number, and alternate 

phone number; and the name of an alternate contact person. 

Print on check as This is the vendor's name as it will appear on printed checks you send 

to the vendor. QuickBooks prefills this field with the vendor's company 

name, but you can edit the name if you want it to print differently on 

your checks.. 

 

5 Click the Additional Info tab. Enter the following information about your credit terms with the 

vendor and how you want to categorize the vendor on your reports: 

 

Account Enter any information that you want QuickBooks to print in the Memo 

field on checks that you send to the vendor. For example, if you enter 

your company's account number with the vendor, QuickBooks 

automatically adds the account number to the Memo field on each bill 

payment check that goes to that vendor. (You can also enter a short 

note or message instead of an account number.) 

 

Type This is a word or phrase that categorizes this vendor for your reports. 

You can choose a vendor type you have already set up from the drop-

down list, or you can enter a new vendor type and have QuickBooks 

add it to the list.Examples 
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 8 

 

Terms This field lets you associate a specific set of payment terms with the 

vendor. You can choose an existing set of terms from the drop-down 

list, or you can enter a new set of terms and have QuickBooks add it to 

the list.ExampleHow the terms are used 

Credit limit Enter the credit limit that your company has with this vendor. 

QuickBooks remembers the limit and warns you when you are about to 

exceed the limit. 

Opening balance These two fields apply only if you are setting up records for a new 

QuickBooks company. They help you establish a correct accounts 

payable balance as of the  start date you chose for your QuickBooks 

records.How to enter the opening balance 

 

6 1099s. If you send a 1099-MISC form to this vendor, do the following: 

 

Fill in the Tax ID field. If the vendor is a sole proprietor, enter the vendor's social security number. If the 

vendor is not a sole proprietor, enter the vendor's nine-digit tax identification number. 

Select the "Vendor eligible for 1099" checkbox. 

 

If the checkbox isn't there 

 

7 (Optional) On the Additional Info tab, fill in any custom fields that apply to this vendor. 

 

How to create custom fields 

 

8 Record the information you entered by doing one of the following: 

 

 Click Next to add another vendor to the list. 

 Click OK to close the window. 

 

Jobs 
 

QuickBooks lets you track each job you do for a customer separately from all other jobs. That way, your 

reports can show your income and expenses by job. The jobs you set up appear on your Customer:Job list. 

 

Instructions 

 

1 From the Customer:Job list, select the customer whom the job is for. 

2 Click Add Job. 

3 Fill in the New Job window 

 

For help with the fields, click here. 

 

4 Click Next to enter another new job, or click OK to close the window. 

 

Classes 
 

Classes are another method that you can use to track and classify your income and expenses (the first 

method is by customer and job). When class tracking is on in the Transaction Preferences window, 

QuickBooks adds a Class field to the windows where you enter transactions. You can fill in this field by 

choosing a class from your Class list. 
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 9 

 

Instructions 

 

1 From the Lists menu, choose Class. 

2 Click New. 

3 Enter a name for the class. 

4 (Optional) If you want the class to be a subclass of another class, select the "Subclass of" 

checkbox and enter the name of the parent class. 

5 Click Next to enter another new class, or click OK to close the window. 

 

Adding an employee 

 

QuickBooks uses the Employee list to hold information about your employees. You can add new 

employees to the list at any time. 

 

Instructions 

 

1 From the Lists menu, choose Employee. 

2 Click New. 

3 On the Address Info tab, enter the following information about the employee: 

 

4 (Optional) Click the Additional Info tab. Fill in any custom fields that apply to this employee. 

 

5 If you track payroll, click the Payroll Info tab. Fill in the wage, withholding, sick time, and 

vacation time information for this employee. 

6   

6 Record the information you entered by doing one of the following: 

 

Sales Invoices 
 

Filing in a sales form / Invoice 

 

QuickBooks' sales forms -- invoices, sales receipts and credit memos --all work the same way. The 

following procedure describes the steps for filling in any of these forms. 

 

Instructions 

 

1 From the Activities menu, choose Create Invoices, Enter Cash Sales, or Create Credit Memos. 

2 Enter the name of the customer in the Customer:Job field. 

3 (Invoices and credit memos only) Choose which accounts receivable account to use. 

4 (Optional) Assign a class to the sale. 

5 Fill in the top part of the sales form. 

6 Complete the line item area. 

7 (Optional) Enter a message for your customer in the Customer Message field. 

8 (Optional) Change the sales tax shown in the Tax field. 

9 (Optional) Enter a memo for this sale. 

10 If you want to print this sales form along with others that you have entered, make sure that the "To 

be printed" checkbox is selected. 

11 Record the sale: 

 

 To record the sale and then enter another, click Next. 

 To record the sale and close the window, click OK. 
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 10 

Editing invoices and sales receipts 

 

You can edit a sales form in the same window where you created it. This is handy when you forget a line 

item or discover an error when you see the printed form. 

 

Instructions 

 

1 From the Lists menu, choose Chart of Accounts. 

2 For an invoice, select your accounts receivable account; for a cash sale, select Undeposited funds. 

3 Click Use Register. 

4 In the register, click the transaction you want to edit. 

5 Click Edit. 

6 Edit, as needed, the information on the form. 

7 Click OK. 

Deleting a transaction 

 

If you need to cancel out the amount of a transaction, you have two choices: you can void the transaction or 

delete it. Voiding changes the amount of the transaction to zero, but keeps a record of the transaction in 

QuickBooks. Deleting removes the transaction altogether from QuickBooks. 

 

To void a transaction 

 

1 Display the transaction you want to void, or select it in the register where it is recorded. 

2 From the Edit menu, choose Void. 

3 Click OK. 

 

To delete a transaction 

 

1 Display the transaction you want to delete, or select it in the register where it is recorded. 

2 From the Edit menu, choose Delete. 

3 Click OK to confirm that you want to delete the transaction. 

 

Sales reports 
 

Sales reports give you information about what you have sold and to whom. To create one of these reports, 

choose Sales Reports from the Reports menu and then choose the report you want. 

 

Report type Description 

By Item Summary Summarizes your month to date unit and dollar sales, subtotaled by 

invoice item (for parts, services, discounts, or other charges). 

By Item Detail Like the item summary report, but with sales transactions listed for each 

line item for this month. 

By Customer Summary Summarizes your sales income (for parts, services, discounts, or other 

charges) by customer for this month.   

By Customer Detail Like the customer summary report, but with sales transactions listed for 

each customer. 

By Rep Summary Summarizes your sales income (for parts, services, discounts, or other 

charges) by employee for this month. 

By Rep Detail  Like the employee summary report, but with sales transactions listed 

for each employee. 

Pending Sales Lists all invoices, cash sales, and credit memos that are marked as 

pending. Shows the account that is affected when the sale is marked as 

final. 
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 11 

Bills 
 

If you receive a bill, you use QuickBooks' bill form to record the transaction. You can record bills for 

expenses such as utilities or office supplies, or for items you've ordered and received from vendors. When 

you enter a bill, QuickBooks automatically posts the amount to the correct expense account and updates 

your company's balance with the vendor who sent the bill. 

 

If you use QuickBooks' accounts payable, you'll get the most benefit if you enter bills as soon as you 

receive them. That way, your cash flow reports will be up-to-date, and you won't run the risk of setting bills 

aside for later and forgetting about them. 

 

When you enter a bill, it can be for: 

 

1. Expenses you track through expense accounts 

2. Items you track through your Item list 

 

Click the situation that applies. 

 

Entering a bill for expenses 
 

You can enter a bill for any kind of expense you track through expense accounts. 

 

Instructions 

 

1 From the Activities menu, choose Enter Bills. 

2 Fill in the bill form in the top half of the window. 

3 (Optional) Enter a memo about the bill. 

 

The memo you enter will appear on reports that include the bill. If you pay the bill by check, QuickBooks 

puts the memo in the Memo field of the check if you did not enter an account number when you set up the 

vendor's record. If you did enter an account number, the account number appears in the Memo field of the 

check. 

 

4 If the Enter Bills window displays two tabs labeled Expenses and Items, click the Expenses tab. 

 

These tabs appear when the "Inventory and purchase orders are active" checkbox is selected in the 

Inventory/Purchase Order Preferences window. 

5 In the detail area, assign the bill to one or more expense accounts. 

6 Record the bill: 

 

Entering a bill for items 
 

You can enter a bill for inventory part, non-inventory part, service, and other charge items. When you enter 

a bill for items, you use the Items tab in the Enter Bills window. 

 

Instructions 

 

1 From the Activities menu, choose Enter Bills. 

2 Fill in the bill form in the top half of the window. 

3 (Optional) Enter a memo about the bill. 

 

The memo you enter will appear on reports that include the bill. If you pay the bill by check and you did 

not enter an account number when you set up the vendor's record, QuickBooks puts the memo in the Memo 
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 12 

field of the check. If you did enter an account number, the account number appears in the Memo field of 

the check. 

 

4 Click the Items tab. 

 

If there is no Items tab 

 

5 Did you write a purchase order for the items? 

 

If . . . Do this 

Yes Click Select PO and select the POs that contain the items you're receiving.More detail 

No Enter the items in the detail area.More detail 

 

6 To enter shipping charges or taxes not associated with any one item, click the Expenses tab. In the 

detail area, enter each charge and associate it with its correct expense account. 

 

7 Record the bill: 

 

Paying bills 
 

In the Pay Bills window, you can have QuickBooks list all unpaid bills or all bills due as of a date you 

enter. You mark the bills you want to pay, and QuickBooks then writes and records the checks or credit 

card charges. If you pay by check, all you do is print (or write) the checks when you're ready. 

 

To pay your bills 

 

1 From the Activities menu, choose Pay Bills. 

2 Fill in the fields at the top of the Pay Bills window. 

 Required fields. At a minimum, you must fill in these fields: 

 

Pay By. Click the method you are going to use to pay the bills ("Check" or "Credit Card"). Then enter the 

name of the checking or credit card account from which you will pay the bills. 

Show bills due on or before. This date determines which bills QuickBooks displays in the list (bills due 

after the date do not appear). You can enter a different date if needed. Select this item or "Show all bills". 

Show all bills. Select this item if you want QuickBooks to display all your bills in the list. Select this item 

or "Show bills due on or before". 

 

Optional fields. Fill in these fields as needed: 

 

Payment Date. This is the date that will appear on your printed checks. QuickBooks automatically enters 

today's date. You can enter a different date if needed. 

 

To be printed. Select this checkbox if you plan to print checks. 

Account. If you want QuickBooks to pay these bills from a different checking (or credit card) account, 

enter the account name in this field. 

 

Sort Bills by. This field controls the order in which the bills appear in the list. You can choose Due Date 

(oldest first), Discount Date (oldest first), Vendor (A through Z), or Amount (largest first). 

3 Select the bills you want to pay. 

 

Click in the  column to select individual bills for payment. To select all the bills, click Pay All Bills. 
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 13 

As you select the bills, compare the total in the Amt Paid column against the total shown for "Ending Bank 

Balance." This tells you whether you have enough money in your checking account to cover all the bills 

you've selected to pay. 

 

If some bills seem to be missing from the Pay Bills window and you selected "Show bills due on or 

before", check that the date shown for this field is the date you want. 

For example, if the date in the field is May 1st, any bills due after May 1st will not be listed. To list a bill 

due on May 5th, you must enter May 5th (or a later date) in the field. 

 

4 If you want to pay only part of a particular bill, edit the amount shown in the Amt Paid column. 

5 Record the payment: 

 

To record the payment and then enter another, click Next. You might click Next if you want to use different 

payment dates for your bills, or you want to pay them from different checking accounts. Also, click Next if 

you want to create multiple checks for the same vendor. 

To record the payment and close the window, click OK. 

6 If you write checks by hand, record the correct check numbers in the check register. 

 

To print your checks 

 

1 Choose Print Forms from the File menu. 

2 Choose Print Checks. 

 

Setting up tax rates and agencies 

 

Before you can charge and track sales tax with QuickBooks, you must let QuickBooks know which 

agencies you collect tax for, and at what rates. You do this by creating tax items. A tax item represents a 

single tax rate payable to a single agency. If you happen to collect for more than one agency, you can create 

a separate tax item for each agency and then group the items together so that your customers will only see a 

single tax rate on your sales forms. 

 

Tax 
 

Setting up tax rates and agencies 

 

Creating tax items 

 

You need to create a separate sales tax item for each tax whose amount you must report. Follow the 

procedure below until you have created as many tax items as you have single taxes. 

 

Instructions 

 

1 From the Lists menu, choose Items. 

2 Click New. 

3 From the Type list, select Sales Tax Item. 

4 Enter a tax name. 

 

This name becomes one of the sales tax choices available to you when you are filling in a sales form. 

 

5 Enter a description to describe this sales tax on your sales forms. 

 

The description prints on your sales forms after the final line item. You cannot edit it on the forms 

themselves. 
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 14 

 

6 Enter the tax rate. 

 

QuickBooks assumes the rate is a percentage. For example, enter 7.25 if the rate is 7.25%. 

 

7 Enter the tax agency to whom you pay the tax. 

 

If the tax agency is not already on your Vendor list, QuickBooks adds it to your list now. Click Quick Add 

to add just the name of the agency to the list; click Set Up to add additional information, such as the 

agency's address. 

 

8 Record your entries: 

 

Deposits 
 

Depositing customer payments 

 

QuickBooks holds income from sales in an account called Undeposited Funds until you record it as a 

deposit in your checking account. When you choose Make Deposit from the Activities menu, QuickBooks 

first shows you a list of all the payments in Undeposited Funds so that you can select the ones you want to 

deposit. 

 

Instructions 

 

1 From the Activities menu, choose Make Deposit. 

2 If you have payments to deposit, click the ones you'd like to deposit now. 

 

Tip 

 

3 Click OK. 

4 In the Make Deposits window, select the account you'd like to deposit into. 

5 In the detail area of the Make Deposits window, enter any amounts to deposit that are not 

payments you received through sales to customers. 

 

6 Click OK. 

 

Checks 
 

Writing a check for expenses 

 

You can write a check for any kind of expense you track through expense accounts. 

 

Instructions 

 

1 From the Activities menu, choose Write Checks. 

2 In the Bank Account field, choose the account from which you'd like to write this check. 

3 Fill in the check face in the top part of the window. 

4 If the Write Checks window displays two tabs labeled Expenses and Items, click the Expenses tab. 

 

These tabs appear when the "Inventory and purchase orders are active" checkbox is selected in the 

Inventory/Purchase Order Preferences window. 
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5 In the detail area, assign the expenses to one or more expense accounts. 

6 Record the check: 

 

Assets and Depreciation 

Setting up asset accounts to track depreciation 

 

There are several "right" ways to track fixed assets and depreciation. The following is one suggested 

method. If you have been using a different method, it's perfectly all right to continue your current practice 

in QuickBooks. 

 

Instructions 

 

1 Create a fixed asset account for each asset (or group of assets) you want to depreciate. 

 

The account can represent either a single asset or a group of related assets. When you create the 

account, follow these guidelines: 

 

 Make the account type "Fixed Asset." 

Give each account a name that indicates which asset(s) it is tracking. Examples: Truck, Office 

Furniture, Computer. 

 Leave the opening balance at 0.00. 

 

2 Add two subaccounts to each asset account you created. One subaccount tracks the cost of the 

asset, the other tracks accumulated depreciation. 

 

 When you create the subaccounts, follow these guidelines: 

 

 Each "parent" account must have two subaccounts. 

Name the first subaccount something like "Cost" and the second subaccount something like 

"Accumulated Depreciation." In your chart of accounts, these names will help you distinguish the 

two subaccounts: 

 

Truck 

Cost 

Accumulated Depreciation 

 

For the Cost subaccount, enter the original cost of the asset in the Opening Balance field. Enter the date you 

purchased the asset in the As of field. 

 

For the Accumulated Depreciation subaccount, type 0.00 as the opening balance if you acquired the asset 

after your QuickBooks start date. If you acquired the asset before the start date, enter instead the 

accumulated depreciation of the asset as of the start date. Enter this amount as a negative number. 

 

Entering a depreciation transaction 
 

When it's time to enter depreciation for an asset, you can use the register for the asset's accumulated 

depreciation account. 

 

Important. Determining the amount of depreciation to deduct can be a complex process, and the IRS rules 

on the subject change often. Ask an accountant for help in figuring actual depreciation amounts. 

 

Instructions 

07
28

 7
76

 3
17

w
w
w
.m

as
om

om
si
ng

i.c
om



 16 

 

1 From the Lists menu, choose Chart of Accounts. 

2 Select the subaccount that tracks accumulated depreciation for the asset you're depreciating. 

3 Click Use Register. 

4 Enter the transaction in the bottom of the register: 

 

 Enter the depreciation amount as a decrease in the register. 

 In the Account field, enter the expense account you set up to track depreciation. 

 

5 Click Record. 

 

Effect on your accounts 

 

In the asset's fixed asset account, QuickBooks subtracts the depreciation amount from the current value of 

the asset. 

In the account that tracks depreciation, QuickBooks enters the depreciation amount as an increase to your 

company's depreciation expense. 

 

Inventory 

Setting up for inventory 

 

If your business purchases items ready for resale, keeps them in inventory, and then sells them, 

QuickBooks can track the current number in stock and the value of your inventory after every purchase and 

sale. 

 

Setting up to track inventory requires three steps: 

 

1. Turn on inventory tracking 

2. Set up the accounts you need 

3. Add inventory part items to your Item list 

 

Turning on inventory tracking 

 

QuickBooks has a preference for tracking inventory. When you created your company, QuickBooks asked 

whether you tracked inventory. If you answered Yes, the preference is turned on. 

 

To turn the preference on 
 

1 From the Preferences menu, choose Inventory/PO's. 

2 Select the "Inventory and purchase orders are active" checkbox. 

3 Click OK. 

 

Setting up accounts for inventory 
 

You need at least one each of the following types of accounts in your chart of accounts to track inventory. 

Follow these guidelines when you set up the accounts: 

 

Suggested Name Account type/comments 

 
Inventory value Other Current AssetQuickBooks uses this account to track the current 

value of your inventory. If you want, you can set up subaccounts within 

this account to track the value of different types of inventory. 
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Sales IncomeQuickBooks uses this account to track the income from the resale 

of inventory items. If you want, you can set up subaccounts within this 

account to track the income from different types of inventory. 

Cost of goods sold Cost of Goods SoldQuickBooks uses this account to track the cost to 

you of the items you have sold. If you want, you can set up subaccounts 

within this account to track the costs for different types of inventory 

sold.On a profit and loss report, QuickBooks subtracts the total cost of 

goods sold from your total income to provide a gross profit before 

expenses. 

 

Creating items for inventory 
 

Use inventory part items to represent materials or parts you buy, track as inventory, and then resell. 

Through inventory part items, you can keep track of how many items remain in stock after a sale, how 

many items you have on order, your cost of goods sold, and the value of your inventory. 

 

You can use the same inventory part item on both sales forms and purchase orders. You do not need to 

create a separate set of inventory items specifically for purchases. 

 

Instructions 

 

1 From the Lists menu, choose Items. 

2 Click New. 

3 From the Type drop-down list in the New Item window, choose Inventory Part. 

 

If  Inventory Part isn't on the list 

 

4 Enter an item name or number. 

 

What you enter here appears on the drop-down list of items when you are filling out a sales form or 

purchase order. Enter a name or number that will help you distinguish this item from all the others on the 

list. 

 

5 Fill in the purchase information fields for easy reordering of stock. 

 

How to fill in the fields 

 

6 Fill in the sales fields for information you show to customers. 

 

How to fill in the fields 

 

7 If this is a new item that you are adding to your inventory, leave the Quantity on Hand and Total 

Value at zero. 

 

Guidelines for existing items 

 

8 (Optional) Fill in any custom fields that apply to this item: 

 

 Click Custom fields. 

 Fill in the fields and click OK. 

 

How to create custom fields 

 

9 Record the item: 

 

 To record the item and then enter another, click Next. 
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 To record the item and close the window, click OK. 

 

Reports 
 

Creating a report 

 

It's easy to create a report. Just choose the report you want from the Reports menu or one of its submenus. 

QuickBooks searches your data and then displays the report. 

 

Instructions 

 

1 From the Reports menu, choose one of the report categories. 

2 Choose the type of report you want from the sub-menu that appears. 

 

Viewing more of a report on your screen 

 

To view more of a report that's too long or wide to fit on the screen, click the vertical and horizontal scroll 

bars at the right and bottom of the report window. 

You can also see more of a report by clicking certain buttons on the buttonbar: 

 

Click . . . To do this 

Hide Header Hide everything in the report header (company name, report title, date 

range, today's date, etc.). This button does not affect the printed report. 

Show Header Display the report header you previously hid. 

Collapse Hide subaccounts, jobs, and subclasses; by summarizing their amounts 

under the main heading. This button affects both the onscreen and 

printed report. 

Expand Display the subaccounts you previously hid. 

 

Filters 

 

Changing what a report covers (filtering) 

 

When you create a report, you may want to limit it to transactions that meet the criteria you specify. This is 

called filtering the report. For example, if you create a vendor balance detail report (one of the A/P reports), 

QuickBooks displays a report that shows every vendor. To have your report focus on a few specific 

vendors, you need to filter the report. 

 

Instructions 

 

1 Create the report. 

2 In the Report window, click Filters. 

3 Use these fields and options to tell QuickBooks which transactions you want to include in the 

report: 

 

 Transaction Date  

 Name  

 Customer Type  

 Vendor Type  

 Source 

 Class  

 Memo  

 Account  

 Document No  
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 Transaction Type  

 Payroll item 

 Job Type 

 Date entered/Last modified 

 Cleared  

 Received 

 Amount  

 

4 If you want to limit the report to specific sales and purchase transactions, click Invoice Options (in 

spite of its name, the Invoice Options button lets you filter all sales and purchase transactions, not just 

invoices). In the window that appears, use these fields and options to tell QuickBooks which 

transactions you want to include in the report: 

 

 Due Date  

 Paid Status  

 Aging  

 Ship Date 

 Items, Via, Terms, Payment Method, Rep , or FOB.  

 

5 Click OK. 

6 (Optional) Click Memorize to memorize the filter settings. 

 

By memorizing the filter settings, you can create similar reports in the future without having to re-enter the  

settings each time. 

 

Cash basis transaction report examples 

 

A cash basis transaction report can look complicated when the report includes items that post to balance 

sheet accounts. This is because the report has to show a balancing entry for each amount. Without the 

balancing entries, your company finances would be out of balance. 

 

Example 1: Payment in full for an invoice 

 

You sell an item from your inventory to a customer on August 31st. The item's cost is $10.00; its sales 

price is $25.00. On September 1st, you receive a payment for the full $25.00. A cash basis transaction by 

date report represents the two transactions as follows: 

 

When you recorded the invoice, you sold an item whole value as inventory was $10.00. Accordingly, your 

Inventory Asset account decreases by $10.00. To balance this amount, Accounts Receivable increases by 

$10.00: 

 

When you applied the customer's payment to the invoice, you incur the cost of selling the item. 

Accordingly, your Cost of Goods Sold Account increases by $10.00. To balance this amount, Accounts 

Receivable decreases by $10.00: 

 

Because the customer's payment was $25.00, the Sales account (where you track sales income) decreases 

by $25.00. (The account decreases because accounting conventions treat income as a negative number.) To 

balance this amount, Accounts Receivable increases temporarily by $25.00: 

 

Finally, the Undeposited Funds account increases by $25.00, the amount that the customer paid. 

(Undeposited Funds is where QuickBooks "holds" money you receive until you deposit it in a bank 

account.) To balance this amount, Accounts Receivable decreases by $25.00: 

 

The net effect on the accounts is as follows: 
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 Inventory Asset decreases by $10.00. 

 Cost of Goods Sold increases by $10.00. 

 Sales decreases by $25.00. 

 Undeposited Funds increases by $25.00. 

 Accounts Receivable remains unchanged. 

 

Note that the total of all the changes is $0.00. Your accounts are in balance. 

 

Example 2: Partial payment of an invoice 

 

What happens when you receive a partial payment for an invoice? Let's assume the same invoice as before, 

but this time you receive a payment of $12.50 -- half of the invoice total. The cash basis transaction report 

now looks like this: 

 

Notice that QuickBooks has reduced all of the September 1st amounts by one half to reflect that fact that 

you only received half of the invoice total: 

 

Cost of Goods Sold increases by $5.00, not $10.00 as in the previous report. The cost of the sale is one half 

of the item's inventory value, not its full value. 

 

Sales decreases by $12.50, not $25.00 as in the previous report. 

Undeposited Funds increases by $12.50, not $25.00 as in the previous report. 

 

Each of these entries corresponds to a balancing entry in Accounts Receivable. As in the previous report, 

the total of all the entries is $0.00. 

A/R reports 

 

A/R reports give you information about the "receivables" side of your business -- which invoices are due 

(or overdue), how much each customer owes your company, etc. To create one of these reports, choose A/R 

Reports from the Reports menu and then choose the report you want. 

 

Report type Description 

Aging Summary Shows when invoice payments are or were due, subtotaled by 

customer. 

Aging Detail Lists each unpaid invoice, and open credit memo, grouped and 

subtotaled by days overdue (aging period).  Tells how many days an 

invoice is overdue. 

Open Invoices Lists each unpaid invoice, grouped and subtotaled by customer. 

Collections Report When you specify a number of days, this report displays which 

invoices are overdue by that number of days, along with customer 

names and phone numbers so you can contact delinquent customers. 

Customer Balance Summary Shows balances for customers with unpaid balances, as of the ending 

date. 

Customer Balance Detail Lists each invoice, credit memo, payment, cash sale, and general 

journal entry, subtotaled by customer.  Total for customer equals 

customer's unpaid balance. 

A/P reports 

 

A/P reports give you information about the "payables" side of your business, including which bills are due, 

your sales tax liability, and your current balance with each vendor. To create one of these reports, choose 

A/P Reports from the Reports menu and then choose the report you want. 

 

Report type Description 
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Aging Summary Shows the aging status of your unpaid bills in your accounts payable 

account, subtotaled by vendor. 

Aging Detail Lists each unpaid bill, subtotaled by aging period.  Tells how many 

days a bill is overdue. 

Unpaid Bills Detail Lists each unpaid bill, subtotaled by vendor. 

 Sales Tax Liability Report Summarizes how much sales tax you billed 

(or collected) on behalf of each sales tax agency, for the date range you 

specify. You can specify whether this report is on a cash or accrual 

basis in the Sales Tax Preferences window. 

Vendor Balance Summary Shows balances for vendors with unpaid balances, as of the report's 

ending date. 

Vendor Balance Detail Lists all vendor-related transactions, subtotaled by vendor. The total for 

a vendor equals the vendor's unpaid balance. 

1099 Report Summarizes your cash outflows by vendor for a calendar year. Useful 

in collecting data for U.S. tax forms 1099-MISC and 1096. You can 

specify that the report shows only 1099 vendors or 1099 accounts. You 

can also specify whether the report shows 1099 categories whose 

amounts fall below IRS threshold requirements. 

1099 Detail Like the 1099 report, but with lists the cash outflow transactions that 

contribute to each vendor's total. You can specify that the report shows 

only 1099 vendors or 1099 accounts. 

Transaction reports 

 

Transaction reports list transactions that occurred within a specific period of time and that match specific 

criteria. To create one of these reports, choose Transaction Reports from the Reports menu and then choose 

the report you want. 

 

Report type Description 

By Date Lists all individual transactions for this month by date. 

By Customer Lists individual transactions for this month to date, but grouped and 

subtotaled by customer. 

By Vendor Lists individual transactions for this month to date, but grouped and 

subtotaled by vendor. 

 

Transaction detail reports 

 

Transaction detail reports list the details of transactions that occurred within a specific period of time and 

that match specific criteria. To create one of these reports, choose Transaction Detail Reports from the 

Reports menu and then choose the report you want. 

 

Report type Description 

By Account Lists the details of individual transactions for this month to date, 

subtotalled by each account on your chart of accounts. 

By Date Lists individual the details of transactions for this month to date. Each 

account involved in a transaction appears on a separate line. Displays 

the open balance and the original amount of each transaction. 

Profit and loss reports 

 

Profit and loss reports give you a global view of your company's income, expenses, and net profit or loss 

over a specific period of time. To create one of these reports, choose Profit & Loss from the Reports menu 

and then choose the report you want. 
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Report type Description 

Standard Summarizes your income and expenses, subtotaled by income or 

expense account, so you can tell whether you're operating at a profit or 

a loss. Some people call this type of report an income statement. 

YTD Comparison Like the standard profit and loss statement, but with columns for this 

year to date, $ change, and % change. 

Prev Year Comparison Like the standard profit and loss statement, but with one column for 

this month to date and a second column for this year to date. 

By Job Like the standard profit and loss statement, but with columns for each 

job. Amounts are for this year to date. 

By Class Like the standard profit and loss statement, but with columns for each 

class. Amounts are for this year to date. 

Itemized Shows year to date transactions (instead of totals only) for each income 

and expense account. 

Income by Customer Summary Summarizes year to date sales income by customer and job. 

Income by Customer Detail Lists year to date sales (or return) transactions, grouped and subtotaled 

by customer and job. 

Expenses by Vendor Summary Summarizes year to date net expenses by vendor. 

Expenses by Vendor Detail Lists year to date expense (or credit) transactions, grouped and 

subtotaled by vendor. 

Balance sheet reports 

 

Balance sheet reports show the financial position of your business by listing assets, liabilities, and equity. 

To create one of these reports, choose Balance Sheet from the Reports menu and then choose the report you 

want. 

 

Report type Description 

Standard Shows -- as of today -- the balance in each balance sheet account, with 

subtotals for assets, liabilities, and equity. 

Comparison Has columns for today, a year ago, $ change, and % change. 

Summary Shows amounts for each account type but not for individual accounts. 

Itemized Shows balances as of last month and today, and shows transactions for each 

account for this month. 

Sales reports 

 

Sales reports give you information about what you have sold and to whom. To create one of these reports, 

choose Sales Reports from the Reports menu and then choose the report you want. 

 

Report type Description 

By Item Summary Summarizes your month to date unit and dollar sales, subtotaled by 

invoice item (for parts, services, discounts, or other charges). 

By Item Detail Like the item summary report, but with sales transactions listed for 

each line item for this month. 

By Customer Summary Summarizes your sales income (for parts, services, discounts, or other 

charges) by customer for this month.   

By Customer Detail Like the customer summary report, but with sales transactions listed for 

each customer. 

By Rep Summary Summarizes your sales income (for parts, services, discounts, or other 

charges) by employee for this month. 

By Rep Detail  Like the employee summary report, but with sales transactions listed 

for each employee. 

07
28

 7
76

 3
17

w
w
w
.m

as
om

om
si
ng

i.c
om



 23 

Pending Sales Lists all invoices, cash sales, and credit memos that are marked as 

pending. Shows the account that is affected when the sale is marked as 

final. 

Purchase reports 

 

Purchase reports give you information about your purchases. To create one of these reports, choose 

Purchase Reports from the Reports menu and then choose the report you want. 

 

Report type Description 

By Item Summary Summarizes your unit and dollar purchases for this month, subtotaled 

by item. 

By Item Detail Like the previous report, but with credit card charges, bills, vendor 

credits, and checks listed for each item. 

By Vendor Summary Summarizes your purchasing expenses by vendor for this month. 

By Vendor detail Like the previous report, but with credit card charges, bills, vendor 

credits, and checks listed for each vendor. 

Open Purchase Orders Shows all open purchase orders, including the vendor, PO number, and 

expected receipt date. 

 

Budget reports 

 

Budget reports show how your income and expenses compare to the budgets you have set up. To create one 

of these reports, choose Budget Reports from the Reports menu and then choose the report you want. 

 

Report type Description 

P&L Budget Overview Shows budgeted amounts by month for each income and expense 

account for which you have set up a budget. 

P&L Budget vs. Actual Compares budgeted amounts for income and expense accounts with 

actual income and expenses. Shows the difference in dollars and as a 

percentage of budgeted amount. 

P&L Budget by Job Overview Shows budgeted amounts by month and by job for each income and 

expense account for which you have set up a budget for a job. 

P&L Budget vs. Actual by Job Compares budgeted amounts for income and expense accounts for each 

job with actual income and expenses. Shows difference in dollars and 

as a percentage of budgeted amount. 

Balance Sheet Budget Overview Shows annual income and expense budgeted amounts by job. The 

period of time covered is the fiscal year to date. 

Balance Sheet Budget vs. Actual Compares budgeted balances for balance sheet accounts with actual 

balances. Shows the difference in dollars and as a percentage of 

budgeted balance. 

 

Other reports 

 

To create one of these reports, choose Other Reports from the Reports menu and then choose the report you 

want. 

 

Report type Description 

Custom Report Shows totals and subtotals for groups of transactions without showing 

the individual transactions. The default report is similar to the standard 

profit and loss statement but with a single column with amounts for the 
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time period you select. You can customize this report in a variety of 

ways. 

Cash Flow Forecast  Shows expected cash inflows, expected cash disbursements, and 

expected bank account balances, so you can forecast how much cash 

you'll have. 

Income Tax Summary Shows the amount associated with each tax line for the tax form you 

specified in the Company Information window. You choose which 

account is associated with each tax line. 

Income Tax Detail Shows the transactions associated with each tax line for the tax form 

you specified in the Company Information window. You choose which 

account is associated with each tax line. 

Check Detail Shows detailed information for each check, including which expense 

accounts the check affected (in the Account column) and how you 

allocated bill payments (in the Paid Amount column). 

Missing Checks Lists checks in a bank account by check number, invoices in a 

receivables account by invoice number, or payments in a current asset 

account by number. Points out both missing and duplicate numbers. 

Deposit Detail Shows detailed information for each bank deposit, including which 

customers contributed to the deposit (in the Name column) and how 

you allocated payments from customers (in the Amount column). 

Payroll Report Summarizes all transactions related to payroll accounts, as defined in 

the Payroll Information window. This report is available only if you 

select "Payroll Reports only" in the Payroll Preferences window. 

General Ledger Lists month to date transactions, grouped and subtotaled by each 

account on your chart of accounts. This report is similar to the 

transactions by account report. 

Trial Balance Summarizes your debits and credits, subtotaled by each account on 

your chart of accounts, for people familiar with double-entry 

accounting. 

Journal Breaks down every transaction into debits and credits, showing how 

QuickBooks does double-entry accounting automatically. 

Transaction Journal Breaks down the current transaction into debits and credits. 

Transaction History Lists transaction information in two forms: invoices and the payments 

against them, and payments and the invoices they are against. 

Audit Trail For a date range that you specify, shows any transactions modified 

during that period and what the modifications were. Can also show 

deleted transactions. To create this report, you must first select "Use 

audit trail" in the Transactions Preferences window. 

Printing 
Printing a report 

 

You can print any report using your printer. You can also print it to disk (that is, save it on disk) in any of 

three file formats suitable for a word processor or spreadsheet. 

 

Instructions 

 

1 Display the report. 

2 When the report is onscreen, either choose Print Report from the File menu or click Print on the 

report buttonbar. 

3 In the "Print to" section, select one of the four "destinations" for the printed report (Printer, Text 

file, Tab-delimited file, or Comma-delimited file). 
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What the destinations mean 

 

4 (Optional) Click Landscape to print the report in landscape orientation. 

5 (Optional) Click "Fit to one page wide" to scale the report so that all the columns fit across a 

single page. 

 

This option is useful when a report is slightly wider than one page. QuickBooks reduces the size of the 

printed text so that all the columns can appear on one page. 

 

6 (Optional) Click Preview to display what the printed report will look like. 

7 Click Print to start printing the report (or to specify a filename for the disk file). 

 

Graphs 
 

Creating a graph 

 

You can create a QuickInsight graph at any time. 

 

Instructions 

 

1 From the Graphs menu, choose the type of graph you want to create. 

2 (Optional) When QuickBooks displays the graph, click the Dates button on the graph buttonbar to 

change the dates for the graph. 

3 (Optional) Click any button on the graph buttonbar that allows you to group the data in a different 

way. 

 

For example, the sales graphs usually display sales by item, but you can change them to display sales by 

customer or by rep. 

 

4 (Optional) Print the graph by clicking the Print button on the graph buttonbar. 

 

Using Help 
 

How to use QuickBooks Help 

 

 Use QuickBooks Help to get complete information about a window or how to do a particular task. 

 

To open the Help window 

 

 Press F1 

 Choose QuickBooks Help from the Help menu at the right of the menu bar. 

 

To find information in Help 

 

QuickBooks Help gives you several ways to find information. 

 

Click . . . To display 

Contents  A table of contents that directs you to the main subject areas of Help. 

A list of important terms in QuickBooks. You can click entries in the list to display 

popup definitions. 

Index  An alphabetical index of topics in Help. 

A list of topics related to the one you are reading. You can go to any topic simply by 

clicking its entry in the list. 
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Q/A  Answers to commonly-asked questions. 

Example  An example that shows what happens when you the perform instructions you are reading. 

Chart  A chart that shows how the task you are reading about fits in with other related tasks. 

Text in green More detail about a step in a procedure or a term that appears in a paragraph. Green text 

always indicates that you can jump to another topic by clicking the text. 

 

3 Finally, create an expense account to track depreciation expense. Give the account a name like  

 

Audit trails 

Keeping an audit trail 

 

You can have QuickBooks keep a record of all the changes made to transactions. Such a record is called an 

audit trail. 

If you keep an audit trail, you may find that QuickBooks works a little more slowly, and your data will take 

up more disk space. These changes occur because QuickBooks must keep a record of every transaction 

change. (Normally, QuickBooks writes over a transaction when you change it.) 

 

To start an audit trail 

 

1 From the Preferences menu, choose Transactions. 

2 In the Transaction Preferences window, select the Use Audit Trail checkbox. 

3 Click OK. 

 

To view the audit trail report 

 

1 From the Reports menu, choose Other Reports. 

2 Choose Audit Trail. 

 

What the report shows 

 

Transactions that say "Previous Transaction" have been modified. You can compare a "previous" 

transaction against the "current" one to see what has changed. The report also shows the date and time of 

each modification. 

 

Removing audit trail information from your file 

 

Audit trail information increases the size of your company data file. If you need to, you can remove the 

audit trail information by selecting "All audit trail info" when you use QuickBooks' Condense Data 

command to reduce the size of the file. If you have never used the Condense Data command before, we 

suggest that you read the following topic first to learn how this powerful command affects your data: 

 

How QuickBooks condenses data 

 

Reminders 
 

Setting reminders for yourself 

 

You can have QuickBooks remind you when it's time to pay bills, print forms such as invoices and 

purchase orders, print checks, deposit money in the bank, enter memorized transactions, act on overdue 

invoices, or act on To Do notes you've created for yourself. These reminders appear on your Reminders list. 

 

Instructions 
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1 From the Preferences menu, choose Reminders. 

2 For each type of event listed, choose how much detail you would like the Reminders list to show. 

 

Click . . . If you want the list to show 

Show Summary A one line summary that shows the total amount of the transactions 

due. For To Do notes, QuickBooks displays the total number of notes 

due and past due as of the current date. 

Show List A list of all the transactions due with their individual amounts. For To 

Do notes, QuickBooks lists the text of each note. 

Don't Remind Me No information at all. 

 

3 For the date-driven events, enter the number of days in advance that you would like QuickBooks 

to add a reminder to the list. 

4 (Optional) If you want to see the Reminders list each time you start QuickBooks, select the "Show 

Reminders list when QuickBooks starts" checkbox. 

5 Click OK. 

 

Passwords 
 

Setting passwords for your company file 

 

You can set passwords to discourage unauthorized access to your company file and limit particular 

activities within the file. 

 

Instructions 

 

1 From the Preferences menu, choose Passwords. 

2 In the Owner Password field, enter the text  for the owner password. 

3 If you want to restrict access so that some users can only enter new transactions, enter a data entry 

password in the Data Entry Password field. 

4 Write down the new passwords and save them in a secure place. 

 

Important. If you don't remember the owner password, you will not be able to view or print reports, graphs, 

or registers for your company file. You will also be unable to display the Password Preferences window 

again to see what password you entered. 

 

5 Click OK. 

 

Memory 
 

Increasing memory for QuickBooks 

 

If you see a message indicating that QuickBooks does not have enough memory, you can increase the 

amount of memory available to QuickBooks. 

 

QuickBooks for Windows requires that you run Windows 3.1 in 386 enhanced mode. This mode lets 

QuickBooks use virtual memory, a feature of Windows that uses space on your hard disk to simulate 

additional RAM. Your computer acts as if it has more RAM that it really has, but you gain this additional 

"RAM" by giving up some space on your hard disk. 

 

Before you begin 
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Close the windows for any other applications that are running. 

 

This may solve the problem. If it doesn't, follow the instructions below. 

 

To check your virtual memory 

 

1 Exit QuickBooks if it is running. Close any other programs that are running. 

2 In the Windows program Manager, double-click the Control Panel icon. 

 

 If you don't see the Control Panel icon, double-click the Main program group. 

 

3 Double-click the 386 Enhanced icon. In the 386 Enhanced window, click Virtual Memory. 

4 In the Virtual memory window, check the current size of your virtual memory. 

 

If the size is 0, virtual memory is off. See the next procedure for instructions on how to set it up. 

If the size is any number other than 0, virtual memory is on. The number shows how much disk space (in 

kilobytes) Windows is currently using to create virtual memory. 

 

To set up (or change) virtual memory 

 

1 Follow Steps 1 through 3 of the previous procedure to display the Virtual Memory window. 

2 In the Virtual memory window, click Change. 

3 From the Type drop-down list, choose Permanent. 

 

Important. You cannot create permanent virtual memory on an compressed drive. Refer to the manual that 

came with your disk compression program for instructions on how to create uncompressed disk space for 

virtual memory. 

 

4 (Optional) Reduce the size of the virtual memory by entering a lower number in the New Size 

field. 

 

The size that Windows recommends may take up more hard disk space than you care to allocate to virtual 

memory. 

We suggest that you start with 4000K, which is sufficient to run a QuickBooks company file of 15 to 20 

MB on a computer with 4 MB of RAM. If you continue to have memory problems, increase the maximum 

size by increments of 500K until the memory problems no longer occur. 

 

5 Click OK to record your changes. 

7 When Windows asks you if you're sure you want to make changes, click Yes. Then click Restart 

windows. 
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